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1 Introduction

1.1 Preface

PyCorrFit emerged from my work in the Schwille Lab! at the Biotechnology Center of the
TU Dresden in 2011/2012. The program source code is available at GitHub?. Please do not
hesitate to sign up and add a feature request. If you you found a bug, please let me know
via GitHub.

PyCorrFit was written to simplify the work with experimentally obtained correlation curves.
These can be processed independently (operating system, location, time). PyCorrFit sup-
ports commonly used file formats and enables users to allocate and organize their data in a
simple way.

PyCorrFit is free software: you can redistribute it and/or modify it under the terms of the
GNU General Public License as published by the Free Software Foundation, either version
2 of the License, or (at your option) any later version®.

What PyCorrFit can do

e [oad correlation curves from numerous correlators

Process these curves (e.g. background correction, s. Tools section 3.1.1 )

Fit a model function (many included) to an experimental curve

Import user defined models for fitting

Many batch processing features

e Save/load entire PyCorrFit sessions

What PyCorrFit is not
e A multiple-7 correlator

e A software to operate hardware correlators

1.2 System prerequisites
1.2.1 Hardware

This documentation addresses the processing of correlation curves with PyCorrFit. PyCorr-
Fit was successfully used with the following setups:

1. APD: Photon Counting Device from PerkinElmer Optoelectronics, Model: SPCM-CD3017
Correlator: Flex02-01D/C from correlator.com with the shipped software f1ex02-1dc. exe.

2. APD: Photon Counting Device from PerkinElmer Optoelectronics
Correlator: ALV-6000

3. LSM Confocor2 or Confocor3 setups from Zeiss, Germany.

http://www.biochem.mpg.de/en/rd/schwille/
’https://github.com/paulmueller/PyCorrFit
3http://www.gnu.org/licenses/gpl.html
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1.2.2 Software

The latest version of PyCorrFit can be obtained from the internet at http://pycorrfit.
craban.de.

e MacOSx. Binary files for MacOSx >10.6.8 are available from the download page but
have not yet been fully tested for stability.

e Windows. For Windows XP or Windows 7, stand-alone binary executables are avail-
able from the download page.

e Linux. There are executable binaries for widely used distributions (e.g. Ubuntu).

e Sources The program was written in Python, keeping the concept of cross-platform
programming in mind. To run PyCorrFit on any other operating system, the instal-
lation of Python v.2.7 is required. To obtain the latest source, visit PyCorrFit at
GitHub (https://github.com/paulmueller/PyCorrFit). PyCorrFit depends on the
following python modules:

python-matplotlib (> 1.0.1)
python-numpy (> 1.5.1)
python-scipy (> 0.8.0)
python-sympy (> 0.7.2)
python-yaml

python-wxtools
python-wxgtk2.8-dbg

For older versions of Ubuntu, some of the above package versions are not listed in
the package repository. To enable the use of PyCorrFit on those systems, the following
tasks have to be performed:

matplotlib. The tukss-ppa includes version 1.0.1. After adding the repository
(apt-add-repository ppa:tukss/ppa), matplotlib can be installed as usual.

numpy. The package from a later version of Ubuntu can be installed: https:
//launchpad.net/ubuntu/+source/python-numpy/

scipy. The package from a later version of Ubuntu can be installed: https:
//launchpad.net/ubuntu/+source/python-scipy/

sympy. To enable importing external model functions, sympy is required. It is
available from http://code.google.com/p/sympy/downloads/list. Unpack-
ing the archive and executing python setup.py install within the unpacked
directory will install sympy.

Alternatively python-pip (http://pypi.python.org/pypi/pip) can be used to install up-
to-date python modules.

ETEX. PyCorrFit can save correlation curves as images using matplotlib. It is also possible
to utilize Latex to generate these plots. On Windows, installing MiKTeX with “automatic
package download” will enable this feature. On MacOSx, the MacTeX distribution can be
used. On other systems, the packages LaTeX, dvipng, Ghostscript and the scientific latex
packages texlive-science and texlive-math-extra need to be installed.
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2 Theoretical background

2.1 Derivation of FCS model functions

This section introduces the calculation of FCS model functions. It supplies some background
information and points out general properties of correlation functions.

2.1.1 General Autocorrelation function for a single species

FCS model functions describe how the signal F'(t), emitted from a certain observation vol-
ume, is temporally dependent on its own past (autocorrelation) or on some other signal
(cross-correlation). The autocorrelation G(7) of a signal F'(t) is computed as follows:

(F(t)F(t+71))  g(7)

‘O =FeE T For

(1)

G(7) normalized autocorrelation curve
T lag time

(F) the expectation value of F(t). Applying the ergodic theorem, this can be rewritten as the
time average

0F(t) = F(t) — (F(t)) fluctuation of the fluorescence signal

g(7) non normalized autocorrelation curve

The fluorescence signal is dependent on the size and shape of the detection volume (e.g.
Gaussian shaped for confocal setups or exponential decaying for TIRF setups), on the prop-
agator of the diffusing dye (free diffusion, diffusion with flow, etc.), and the brightness and
concentration of the dye under observation [2].
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(F(t))?

g molecular brightness, dependent on excitation intensity, quantum yield, i.e. emission proper-
ties and absorption cross sections of the dye, and the detection efficiency of the instrument.

G(7) (2)

Q 3D molecule detection function, dependent on the shape of the pinholes used for detection
and the excitation laser profile, i.e. the point spread function (PSF).

® diffusion propagator. The distribution of dyes in a liquid follows Fick’s laws of diffusion. For
free diffusion, this is a simple Gaussian distribution.

F' fluorescence signal of the sample. It is defined as

F(t)y=q /d3r Q(r)c(r,t)
with ¢(r,t) being dye distribution (particle concentration) inside the detection volume.

C average concentration of the dye following the dynamics of the propagator ®. Us-
ing the ergodic hypothesis and assuming a normalized molecule detection function
(Ve = [d3r Q(r) = 1), the concentration computes to C' = (F(t))/q.

2.1.2 General Autocorrelation function for multiple species

Most experiments include particles with more than one dynamic property. Labeled particles
may have different size or the temporal dynamics may include a triplet term. For n different
species inside the detection volume, the autocorrelation function becomes:

g9(7) _ Z?:I Z?:l 9i5(7)
(F(t) (F(t))?

)2
i (T) = qiq; /d3r /dBT/Q(I')(I)Z'j (r, v, 7)Q(x) (4)

G(r) = (3)

g(7) non normalized correlation function
9ij(7) non normalized cross correlation between two species ¢ and j. For n species, i,j € [1,...,n].
q; molecular brightness of species 4
Q 3D molecule detection function

®;; diffusion propagator computed from species ¢ with species j. If species 7 and j are indepen-
dently diffusing, then ®;; is zero. C;j;®;;(r,r’',7) = (d¢i(r,0)dc;(r’, 7))

C;; average concentration of objects following the dynamics of ®;;. If i = j, Cj; = C; is the
concentration of the dye .

If the propagators ®;;(z,y, z;2',y, 2’; 7) and the molecule detection function Q(z,y, z) fac-
torize into an axial (z) and a lateral (x,y) part, so will g;;(7):

9i(T) = 4idj * 9ij,=(T) * Gijaay(T) (5)



Following the example with a freely diffusing species A and a laterally diffusing species B
inside a membrane at z = zj, it can be concluded:

944(T) = @5 9aa(T) - Ganay(T)
9BB(T) = Q% “ 9BB,x(T) " 9BBy(T)
9aB(T) = gBa(T) = qaqB - 94B,:(T) - 9aBay(T)
9(r) = gaa(7) +29a5(7) + gBB(T)

To obtain the normalized autocorrelation function, the average (F(t)) has to be calculated:
Fi)= AW
i=1

Fa) = qa / B Q(r)Calr, 1)

Fg(t)= qB /dx/dy Qz,y, 2 = 20)Cp(z,y,t)
(Ft) = (Fa(t)) + (FB(1))

It is noticeable, that Cp is a 2D concentration, whereas C is a 3D concentration. Since
there is no correlation between the two freely diffusing species A and B, gap(7) is zero. The
normalized autocorrelation curve may now be calculated like this:

B g(7)
= Ty
G(r) = gaa(T) + gBa(T)

2.1.3 Cross-correlation

Cross-correlation is a generalization of autocorrelation. Cross-correlation functions are de-
rived in the same manner as autocorrelation functions. Here, signals recorded in two detec-
tion channels are cross-correlated to obtain the correlation function.

(0Fx (£)0Fy (t + 7))
(Fx (1)) (Fy (1))

A cross-correlation analysis of two species labeled by two types of dyes observed in two
corresponding detection channels can be used for binding assays. Only complexes giving
simultaneous signal in both channels contribute to the cross-correlation amplitude. Thus a
finite cross-correlation indicates co-diffusion.

Gxy(T) = (6)

2.1.4 Extension of the theory

By modifying the propagator ® and the detection volume €2, other effects, like triplet blinking
or binding reactions can be quantified. In many cases, analytical solutions to the above
integrals are not straightforward and approximations have to be made. For example, the
Gaussian shaped detection profile in confocal FCS is already an approximation. However,
deviations from the true results are considered to be small [16]. Section 3.3 introduces several
model functions with various detection symmetries and particle dynamics.



2.2 Non-linear least-squares fit

PyCorrFit uses the non-linear least-squares fitting capabilities from scipy.optimize. This
package utilizes the Levenberg—-Marquardt algorithm to minimize the sum of the squares.
More information on this topic can be obtained from the online documentation of leastsq*.
One can define a distance d(G, H) between two discrete functions G and H with the discrete
domain of definition 77 ... 7, as the sum of squares:

n

d(G, H) = Z [G(7i) — H(Tiﬂz (7)

=1

The least-squares method minimizes this distance between the model function G and the

experimental values H by modifying k£ additional fitting parameters aq, ..., ag:
x? = min Z[G(Ti,()él,...,()ék) — H(n)]? (8)
Ay, O i—1

The minimum distance 2 is used to characterize the success of a fit. Note, that if the number
of fitting parameters k& becomes too large, multiple values for 2 can be found, depending
on the starting values of the k& parameters.

2.3 Weighted fitting

In certain cases, it is useful to implement weights (standard deviation) o; for the calculation
of x2. For example, very noisy parts of a correlation curve can falsify the resulting fit. In
PyCorrFit, weighting is implemented as follows:

. = [G(Ti7a17"'7ak) _H(Tl)]2
X?}veighted = alml%k Z (9)
TR =1

- o;
PyCorrFit is able to calculate the weights o; from the experimental data. The different
approaches of this calculation of weights implemented in PyCorrFit are explained in sec-

tion 3.1.

3 Working with PyCorrFit

3.1 Workflow

Figure 1 shows the main window of PyCorrFit. It contains a menu bar to access all tools,
a notebook with tabs, each tab representing a single curve, and a page - the content of the
currently selected tab.

3.1.1 A First Look

PyCorrFit is operated through the menu bar. The File menu lets the user load and save
files as discussed in section 3.2.1. The Tools menu contains several tools that are described
below. The Current Page menu allows the user to perform tasks on the current page. This
includes loading experimental data files or saving the currently viewable correlation curve

“http://docs.scipy.org/doc/scipy/reference/generated/scipy.optimize.leastsq.html#scipy.
optimize.leastsq
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Figure 1, user interface of PyCorrFit: A circular scanning FCS (CS-FCS) curve of DiO on a
supported lipid bilayer (glass substrate) is shown. The measurement yields a diffusion coefficient
of 0.28 yum?s~! (F1 = 1, so only one component is fitted). Note that a 2D diffusion model is used
and not a 3D model (as shown in figure 2).

as ~.csv file or as an image. The Model menu lets the user select a model to create a new
page. The Preferences menu allows the user to use Latex for plotting (section 1.2.2) or
tells the program to be more verbose (spline fits for calculation of weights will be displayed).
The Help menu contains an update function that checks the current program version against
the official release of PyCorrFit. The graphical user interface comes with a bunch of tools
located in the Tools menu. The Tools menu will become active, once a page is added to
the notebook. Each tool opens in a new window. Tools are updated or closed upon change
of the current page.

3.1.2 Loading Experimental Data

ViaFile - Load data files experimental data files are opened and displayed on tab page.
Within the page, the user may choose starting parameters for the fitting, select which pa-
rameters should be variable during fitting (checked means variable) and select a weighting
method. The page displays the experimental and fitted curve, as well as the residuals in the
lower plot.

3.1.3 Data Range Selection

This selects the lag times 7 from the experimental curve that will be displayed. By default,
all data from a file will be displayed.



3.1.4 Background Correction

Performs a background correction according to [12]. The result is a higher amplitude of the
correlation fuction G(0). Backgrounds may be manually set or imported from background
measurements (see supported file formats).

S—B

where S is the average signal of the correlation curve and B is the average background signal.

S 2
Gcorrected(T) = Gmeasured(T) : |: :| (10)

3.1.5 Performing a (weighted) Fit

Weights can be calculated for each data point using the standard deviation from neighboring
points. Since FCS curves naturally have regions where the standard deviation of the exper-
imental data is large (falling inflection points), the standard deviation has to be calculated
from curves that mimic the experimental data. If weighted fitting is used, the weighted
residuals are shown instead of the plain residuals (difference of experimental and theoretical
curve). The following methods for weighting have been implemented:

Spline. A spline is fitted to the experimental curve. Weights are calculated from the
deviation of the experimental data from the spline. If the Verbose mode is enabled
in the Preferences menu, the spline fit will be displayed. The number of knots of
the spline can be changed by adjusting the number in the dropdown menu. In case
of multiple component data, a higher number of knots is required to obtain a fitting
spline. For single component data, up to three knots are sufficient.

Model function. Instead of calculating the weights from a spline, calculate the
weights from the previously fitted model function. This method of weighting is iterative
- the fit should converge!

Average. If an average was created using the Average data tool, the standard de-
viation o; at all data points ¢, calculated from all curves can be used as weights for
fitting.

3.1.6 Overlay Tool: Selecting valid Runs

Display all curves and easily remove outliers by deselecting them.

3.1.7 Batch Control: Fitting Several Curves at Once

Perform fitting operations on all pages. Parameters may be imported from other ~.fesfit-
session.zip-files. Application of parameters and fitting of curves is only executed for pages
with the same model as the current page.

3.1.8 Global Fitting: When Curves Share Parameters

If multiple correlation curves share some of their parameters, a global fit can be applied.
The Overlay tool may be used to select a subset of curves. Selected correlation curves
are added to one array and a least-sqares fit is performed using the parameters the user
chooses within the respective pages. For example, this is used in two-focus FCS, where
two autocorrelation curves and two cross-correlation curves are obtained. These share the
parameters particle number n and diffusion time 74;¢. A global fit can be applied such that
n and 74 are identical for all curves.

10



3.1.9 Average Data: Obtaining an Average of all Runs

Averaging of curves within the session. The Overlay tool may be used to select a subset
of curves. The tool asks if only pages with the same model as the current page should be
used. Pages that do not have the same correlation type (autocorrelation or cross-correlation)
as the current page are not used. The averaging does not work for data where the length
of the correlation curves are not identical. Averaging in this case is not well-defined. For
averaging, please make sure all curves in a series have the same measurement time. A new
page will be created containing the resulting average. The resulting trace is constructed by
appending the traces of the averaged curves. After averaging, the standard deviaton from
all curves can be used as weights for fitting.

3.1.10 Slider Simulation: Which Parameter does What?

This tool is useful to visualize the impact of certain parameters on the shape of the correlation
function or to set proper starting parameters for a fit.

3.1.11 Page Info: a Summary for each Curve

A most verbose information window that shows all there is to know about the current page.
All information that is displayed here will also be saved when exporting a curve as a ~.csv
file with the Current Page menu.

3.1.12 Trace View: Verification and Troubleshooting

If available, view the trace corresponding to the data of the current page. In case of cross-
correlation, two traces will be displayed.

3.1.13 Statistics: Excel-ready Export of Results

Used for large data sets. Save selected parameters (of all pages with the same model as the
current page) as a table of tab separated values into one single file.

3.2 Data file formats
3.2.1 Import: Support for common FCS file formats

PyCorrFit supports numerous data file formats. If a file format is not listed here, there are
two options to make them work with PyCorrFit:

- Conversion to the native PyCorrFit ~.csv file format.

- Implementation of the file format within the readfiles module of PyCorrFit. __init__.py
has to be edited and a script read FileFormat.py has to be added.

Supported file formats:
~.asc files are created by e.g. the ALV-6000 hardware correlator.
~.csv files are the native PyCorrFit data files. See 3.2.3 for more information.

~.fcs files are created by Zeiss” ConfoCor3 software (e.g. AIM4.2 or ZEN2010b).

11



~.mat files are files generated by a Matlab program written by Jonas Ries. This was
implemented for convenience.

~.sin files are created by the Flex correlators from correlator.com.

~.zip files may contain any of the files listed here.

3.2.2 Export and More: Interaction with the User

These are file formats that were designed for PyCorrFit.

3.2.3 .csv data files

The ~.csv file format contains experimental correlation curves and optionally the fitted curve,
the residuals, as well as weighting factors that have been used for fitting. The data are stored
as tab-separated values. PyCorrFit uses this format to export single correlation curves. The
~.csv files are directly readable by any editor on any platform, allow comments throughout
the file and have a well-defined structure. There is a certain syntax that has to be followed
for ~.csv files to be successfully imported by PyCorrFit:

The encoding is preferably UTF-8. However, since no special characters are needed
to save experimental data, any encoding might work. New line characters are \r\n
(Windows).

Comments: Lines starting with a hash (#) as well as empty lines or lines containing
only white space characters are ignored. Exceptions are the keywords listed below.

Units: A ~.csv file may contain one correlation curve, as well as up to two intensity
traces. The time unit is seconds and the count rate (intensity) is measured in kHz.
Correlation curves are assumed to be calculated from fluctuations around zero, thus
the correlation curve has to decrease to zero at large lag times.

The first table inside a ~.csv file contains the correlation curve. The table consists
of either two or four columns of tab-separated values. The first column contains the
lag times in seconds and the second column contains the correlation curve. PyCorrFit
also saves the fitted curve and the residuals in the third and fourth column, as well
as optional weighting factors that were used for fitting. This additional information is
ignored during file import.

First trace: The table containing the correlation curve is considered to have ended
as soon as the keyword # BEGIN TRACE appears at the beginning of a line. Then, the
trace will be read, again as tab-separated values: The first column contains the time
in seconds and second column contains the corresponding signal in KHz.

The optional second trace is initiated with the keyword # BEGIN SECOND TRACE.

AC/CC: To distinguish the types of imported experimental curves (autocorrelation
or cross-correlation), the keyword Data type can be used. If a line starts with either
of the following:

# Data type Cross-correlation

# Data type Autocorrelation

12



then the corresponding string AC or CC will be used to identify the type of the curve
in the user interface. If no data type is specified, an autocorrelation curve is assumed.
Curves may be personalized by using:

# Data type Autocorrelation _Al

This will result in the identifier AC_A1 during import in the user interface. This feature
is useful to e.g. distinguish many -~.csv files of different type inside a ~.zip file.

3.2.4 .zip data files

~.zip files are either used as session files or as containers for bundled correlation curves.
~.fesfit-session.zip files are used to store entire PyCorrFit sessions including all parameters
and modifications. They can be imported as sessions or as experimental curves. ~.zip files
are containers for files containing correlation curves.

3.2.5 .txt model function files

In addition to the built-in model functions, PyCorrFit supports the import of user defined
model functions for fitting. To get started quickly, it is helpful to take a look at some
examples online’. File syntax:

Parameters: PyCorrFit works with the following dimensional representation. Any
other unit has to be derived from these:

— unit of time : 1ms
— unit of inverse time: 1000s™!
— unit of distance : 100 nm

— unit of diffusion coefficient : 10 ym?s™!

— unit of inverse area: 100 ym ™2

— 1unit of inverse volume : 1000 pm =3

The encoding is UTF-8. On Windows, Notepad++ can be used. Under Linux, editors
like gedit or kate can be used.

Comments: Lines starting with a hash (#) (except the first line) as well as empty
lines or lines containing only white space characters are ignored.

Name: The first line contians the name of the correlation function, preceded by a
hash, e.g.
# AC Gauss test.

Definition of parameters To define parameters used by the model function, they
have to be named and given a starting value. Optionally a dimension of the parameter
may be added before the equal sign and separated from the parameter name by a white
space. The dimension is only displayed by PyCorrFit and not processed, e.g.

D [10 pm?/s] = 200.0.

This is done for all parameters of the model function. Parameters may not start with
a G or g. Also, some variables like e or pi are already mapped and must not be used.
The parameter tau is reserved for the corresponding lag times (ms) and may be used
freely.

5“PyCorrFit external model functions” in the download section at http://pycorrfit.craban.de
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e Placeholders: Placeholders must start with a lower g, for example
gTwoD = 1./(1.+D*tau/a*x*2).

e Correlation function: The correlation function is identified by the capital letter G:
G =1./n % gThrD * gScan * gTrip

Figure 2 shows a working example. External models will be imported with internal model
function IDs starting at 7000. Model functions are checked upon import by PyCorrFit. If
the model function does not work, it might be a syntax error, or just an error of sympy.
Sympy is used to check the model and is still under development. Model functions will be
saved upon session saving.

3.3 Implemented model functions

This is an overview of all the model functions that are currently® implemented in PyCorrFit.
To each model a unique model ID is assigned by PyCorrFit. Most of the following information
is also accessible from within PyCorrFit using the Page info tool.

3.3.1 Confocal FCS

The confocal detection volume with the structural parameter

sp =22 (11)
To
has an effective size of
V =22z (12)

where 7y is its lateral and z, its axial (in case of 3D diffusion) extension. Thus, the effective
number of particles is defined as

N=CV (13)
with the concentration C' given implicitly in the model functions. The diffusion coefficient
is calculated from the diffusion time 745 using

1 2 2
D= (ﬁ) _ T (14)
4, diff SP 4, diff
The parameters in the equation above need to be calibrated to obtain the diffusion coefficient.

Usually a reference dye with a known diffusion coefficient is used to determine the lateral
extension of the detection volume ry with a fixed structural parameter of e.g. SP = 4.

Name 2D (Gaufl)
ID 6001
Descr.  Two-dimensional diffusion with a Gaussian laser profile [1,8,10].

G(T) :Ao—F%m (15)
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# CS-FCS 3D+S+T (Confocal)
# Circular Scanning FCS model function. 3D diffusion + Triplet.

## Definition of parameters:

# First, the parameters and their starting values for the model function

# need to be defined. If the parameter has a unit of measurement, then it

# may be added separated by a white space before the "=" sign. The starting
# value should be a floating point number. Floating point abbreviations

# like "le-3" instead of "0.001" may be used.

Diffusion coefficient
[10 um?/s] = 200.0
Structural parameter
= 5.0

Waist of the lateral detection area
[100 nm] = 1.0
Particle number

= 5.0

Scan radius

[100 nm] = 5.0
Frequency

[kHz] = 20.0

Triplet fraction

= 0.1

Triplet time

tautrip [ms] = 0.001

H A HHH ITHBB H S HOH

# The user may wish to substitute certain parts of the correlation function
# with other values to keep the formula simple. This can be done by using the
# prefix "g". All common mathematical functions, such as "sqrt()" or "exp()"
# may be used. For convenience, "pi" and "e" are available as well.

gTrip = 1. + T/(1-T)*exp(-tau/tautrip)

gScan = exp(-(R*sin(pixf*tau))**2/(a**2+D*tau))
gTwoD = 1./(1.+Dxtau/a**2)

glneD = 1./sqrt(1.+D*tau/(wxa)**2)

gThrD = gTwoD * gOneD

# The final line with the correlation function should start with a "G"
# before the "=" sign.

G = 1./n * gThrD * gScan * gTrip

Figure 2, user defined model function for PyCorrFit: The working example shows a model
function for circular scanning FCS.
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Name
1D

Descr.

Name
1D

Descr.

Name

ID

Descr.

Ay Offset
N  Effective number of particles in confocal area
T Characteristic residence time in confocal area

2D+T (GauBl)

6002

Two-dimensional diffusion with a Gaussian laser profile, includ-
ing a triplet component [1,5,8,10,13,14].

1 1 Te~ /T
At (T 1
G(7) O N+ 7/7am) ( Tt o7 ) (16)

Ay Offset

N  Effective number of particles in confocal area

Taig  Characteristic residence time in confocal area

T Fraction of particles in triplet (non-fluorescent) state
Twip Characteristic residence time in triplet state

3D (GauB})

6012

Three-dimensional free diffusion with a Gaussian laser profile
(eliptical) [1,8, 10].

11 !
G(7) = Ao + N (1 + 7/7an) V1 +7/(SP*1ain)

(17)

Ay Offset

N Effective number of particles in confocal volume

Taig Characteristic residence time in confocal volume

SP  Structural parameter, describes elongation of the confocal volume

3D+T (Gaufl)

6011

Three-dimensional free diffusion with a Gaussian laser profile
(eliptical), including a triplet component [5,13,14].

1 1 1 Te_'r/'rtrip
G(t)=Ap+ — (1 + —) 18
( ) ° N(1+T/7_diff> \/1+T/<SP2Tdiff) 1_T ( )

Ag  Offset

N Effective number of particles in confocal volume

Tag  Characteristic residence time in confocal volume

SP  Structural parameter, describes elongation of the confocal volume
T Fraction of particles in triplet (non-fluorescent) state

Tuwip Characteristic residence time in triplet
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Name
1D
Descr.

Name
1D
Descr.

G(T):A0+

Name
1D
Descr.

2D+2D+T (GauB)

6031

Two-component, two-dimensional diffusion with a Gaussian laser
profile, including a triplet component [1,3,7,12].

1 F , 1 - F Te~/mi
Gr) =4+ NFraa - e 1+T/TI+O‘1+T/TJ (H 1—T> (19)

Ay Offset

N Effective number of particles in confocal area (N = Nj + N)
T Diffusion time of particle species 1

Ty Diffusion time of particle species 2

F Fraction of molecules of species 1 (N; = F'N)

Q Relative molecular brightness of particles 1 and 2 (a = g2/q1)
T Fraction of particles in triplet (non-fluorescent) state

Tuwip Characteristic residence time in triplet state

3D+2D+T (Gaufl)

6032

Two-component, two- and three-dimensional diffusion with a
Gaussian laser profile, including a triplet component [1,3,7,12].

1 1—-F N o’F 1
N1 —F+aF)? |1+7/rp  (1+7/m0) \/1+ 7/(SP%rp)

1 + TefT/Ttrip
1-T

(20)

Ay Offset

N Effective number of particles in confocal volume (N = Nyp + N3p)
Top  Diffusion time of surface bound particles

m3p  Diffusion time of freely diffusing particles

F Fraction of molecules of the freely diffusing species (N3p = F'N)

a Relative molecular brightness of particle species (a« = ¢sp/q2p)

SP  Structural parameter, describes elongation of the confocal volume
T  Fraction of particles in triplet (non-fluorescent) state

Tuwip Characteristic residence time in triplet state

3D+3D+T (GauB)

6030

Two-component three-dimensional free diffusion with a Gaussian
laser profile, including a triplet component [1,3,7,12].

Te~7/Tuiv
N(F +a(l— F))? (H -7 >X (21)

F 1 s 1-F 1
+«

(1+7/m) \/1+7/(5P?7) (L+7/72) \/1+7/(SP?r)

G(T):AO‘F
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Ay Offset
N Effective number of particles in confocal volume (N = N; + Ns)
Ty Diffusion time of particle species 1

Ty Diffusion time of particle species 2

F  Fraction of molecules of species 1 (N; = FN)

o Relative molecular brightness of particles 1 and 2 (« = ¢2/q1)

SP  Structural parameter, describes elongation of the confocal volume
T Fraction of particles in triplet (non-fluorescent) state

Tuwip Characteristic residence time in triplet state

3.3.2 Confocal TIR-FCS

The detection volume is axially confined by an evanescent field and has an effective size of
V = 1 Rydeva (22)

where Ry is the lateral extent of the detection volume and d., is the evanescent field depth”.
From the concentration C, the effective number of particles is N = C'V. The decay constant
k is the inverse of the depth deya :

1
deva = - 23
! 23

The model functions make use of the Faddeeva function (complex error function)®:

u(i€) = ¢ erfe(€) (24)
e 2 [T e
=e ﬁ/g e “da

The lateral detection area has the same shape as in confocal FCS. Thus, correlation functions
for two-dimensional diffusion of the confocal case apply and are not mentioned here.

Name 3D (Gaufl/exp)
1D 6013
Descr. Three-dimensional free diffusion with a Gaussian lateral detec-

tion profile and an exponentially decaying profile in axial direc-
tion [4,6,11].

0 o (V5 e (P)

C  Particle concentration in confocal volume
k  Evanescent decay constant (k = 1/deya)
Ry Lateral extent of the detection volume

D Diffusion coefficient

"Where the field has decayed to 1/e
81n user-defined model functions, the Faddeeva function is accessible through wofz (). For convenience, the
function wixi() can be used which only takes ¢ as an argument and the imaginary i can be omitted.
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Name 3D+2D+4T (Gauf3/exp)

ID 6033

Descr. Two-component, two- and three-dimensional diffusion with a
Gaussian lateral detection profile and an exponentially decay-
ing profile in axial direction, including a triplet component

[1,3,4,6,7,11,12)].

G(T)=A0+

TefT/Ttrip
1+ ——+— 26
N(1—F+aF)2< M >X (26)

1—-F o’Fk Dspt 1 —2Dsp7k?
N T T 4D /R T 14 dDspr /2 (\/ T on w(’ V s

Ay Offset

N Effective number of particles in confocal volume (N = Nop + N3p)
Dyp  Diffusion coefficient of surface bound particles

Dsp  Diffusion coefficient of freely diffusing particles

F Fraction of molecules of the freely diffusing species (N3p = FN)

« Relative molecular brightness of particle species (o« = ¢3p/qop)
Ry  Lateral extent of the detection volume

K Evanescent decay constant (k = 1/deya)

T Fraction of particles in triplet (non-fluorescent) state

Tuwip  Characteristic residence time in triplet state

Name 3D+3D+T (Gaufl/exp)

ID 6034

Descr. Two-component three-dimensional diffusion with a Gaussian lat-
eral detection profile and an exponentially decaying profile in
axial direction, including a triplet component [1,3,4,6,7,11,12].

TeiT/Ttrip
1 27
N(l—F+aF)2<+ =7 )X (27)

Fk DlT+ 1 —2D;7K? ( D ) .
wil TR
1+4Dr/R2\V 7 2 '
(1 - F)a*k Dyt 1 —2Dy7K? (
V Dy7r)
1 iDy R e TR A A

Ay Offset
N Effective number of particles in confocal volume (N = N; + Ns)
D,  Diffusion coefficient of species 1

Dy Diffusion coefficient of species 2
F  Fraction of molecules of species 1 (N; = FN)

G(T) ZA() +

X

o) Relative molecular brightness of particle species (o = ¢2/q1)
Ry Lateral extent of the detection volume

K Evanescent decay constant (k = 1/deya)

T Fraction of particles in triplet (non-fluorescent) state

Tuwip Characteristic residence time in triplet state
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3.3.3 TIR-FCS with a square-shaped lateral detection volume

The detection volume is axially confined by an evanescent field of depth?® de,, = 1/k. The
lateral detection area is a convolution of the point spread function of the microscope of size
0-7

A

U:Ugm, (28)

with a square of side length a. The model functions make use of the Faddeeva function
(complex error function)!:

w(i€) = e erfe(€) (29)
— %/5 e da

Name 2D (Oxo)
ID 6000
Descr. Two-dimensional diffusion with a square-shaped lateral detection

area taking into account the size of the point spread function
[9,15]1.

é = | (o (Cem) 1) e (ﬁ)r .

Particle concentration in detection area
Lateral size of the point spread function
Side size of the square-shaped detection area
Diffusion coefficient

S ° 9 Q

Name 3D (Oxo/exp)

ID 6010

Descr. Three-dimensional diffusion with a square-shaped lateral detec-
tion area taking into account the size of the point spread function;
and an exponential decaying profile in axial direction [9,15].

G(r) = %2 (\/?jt %ﬁw(zﬂn)) X (31)

e (o (o) 1)

X | ————— —erf
Vra? o2+ Dt

C' Particle concentration in detection volume

o Lateral size of the point spread function

a  Side size of the square-shaped detection area
xk  Evanescent decay constant (k = 1/deya)

D Diffusion coefficient

Where the field has decayed to 1/e
10T user-defined model functions, the Faddeeva function is accessible through wofz (). For convenience, the
function wixi() can be used which only takes ¢ as an argument and the imaginary i can be omitted.
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Name
1D

Descr.

Name
1D

Descr.

Name
1D

Descr.

Name
1D

Descr.

2D+2D (Oxo/exp)

6022

Two-component two-dimensional diffusion with a square-shaped
lateral detection area taking into account the size of the point
spread function.

The correlation function is a superposition of two-dimensional

model functions of the type 2D (Oxo) (6000) [9,15].

3D+2D (Oxo/exp)

6020

Two-component two- and three-dimensional diffusion with a
square-shaped lateral detection area taking into account the size
of the point spread function; and an exponential decaying profile
in axial direction.

The correlation function is a superposition of the two-
dimensional model function 2D (Cxo) (6000) and the three-
dimensional model function 3D (Oxo) (6010) [9,15].

3D-+3D ([Oxo/exp)

6023

Two-component three-dimensional free diffusion with a square-
shaped lateral detection area taking into account the size of the
point spread function; and an exponential decaying profile in
axial direction.

The correlation function is a superposition of three-dimensional

model functions of the type 3D (Oxo) (6010) [9,15].

3D-+2D+kin ([Oxo/exp)

6021

Two-component two- and three-dimensional diffusion with a
square-shaped lateral detection area taking into account the size
of the point spread function; and an exponential decaying pro-
file in axial direction. This model covers binding and unbinding
kintetics.

The correlation function for this model was introduced in [9]. Be-
cause approximations are made in the derivation, please verify if
this model is applicable to your problem before using it.
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